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A 422 File > Manage Policies and Layers > New of|A T4t} o] & F2-&
FEEHIA &2 A Zar(defo]-ZW-HE 22 E5F2F pf /.0 54), QoS & A=t
T Express/RecommendedE 112 SmartDashboard’} AHs 22 EHYtt. 7|& A2

Security Policies > Manage Policies oAl QoS 32 f&Z2 5| dych.
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T2 WS 12)7]

722 SmartDashboardol|A] tt&ut}. Default Rule®] &g S ©
2] W BPATEE 2] S5 ol ofy = 92 4 A5 U QoS |ollA ke /IXE L
Rule %S4} 92202 F2g 275t 5 0|58 A3, 8 =89 Jemo= w40
78 DUth 271 921 & tliroll A T oranBottom) T SIClop) QAT 2] oranBelow) o]
(ADove) ME T4 (Add sub-Rule) =l 254tk

mlo

22 22235 72 E7FHAH- B A2 7] - Bo@ 7], Class of Service &7}, £7]7]

(ide) Bl &8 enbisanle) ol B8 22 HyS & 4 J45Yth Hide & oAt

+ Az W= 3 50, Disable & Rule Base OfE YA & sUtt.

ftlo

—
D

N
Fd

=
T

2%

thod o] w3k S0l A Al FA S EE v, TTETTeNe T 105ch 2 H
2 o] tdZg ghdls] 2w A g 4 YUt




zo] It Yst= vhE 2 Holal 14 4 55Ut Source-Destination-Service =

g g2 2223 Add 2 AH|E ¢t (Yt w2, o Terviced] URT Tor Q03 Sl are
2T SoFLRE), Edit-Delete-Cut-Copy-Paste2 thHe-< U th. BEATER ZHR]S A -1

T =1, Where Used & 1 A7} ojt] 2o]=x] & £ 9l Ut Sourceo]= Add

Users Access 2 A2 122 st 2)%] #|$H(No restriction / Restrict to)x= 4

AAE T AHAE ¢E dj= Add with Resources S 21, QoSol|= URI for QoS Bt
AA%E HUTH URIE £ W http:// 22 ZEZEZ 5|5 w) I A5Y(HA URL:
www.my-site.com/pic/qos.gif , AT URL: /pic/qos.gif ). QoS7} A|Ydt= AHEIT A
axb FE|O|H, At 2 AA4FEHA BES FUTH

Action 2 Action €& 225l Edit Properties 2 dUt}. Simplec| ¢S 3} Ezfjy
-8 ofF-Rule Weight-Rule Limit-Rule Guarantee &, Advanced™ 717]°|| Per
connection limit, Guarantee Allocation(Per rule/Per connection), Number of
guaranteed connections, Accept additional connections 7} B3] Yth(Expressol A+

Advanced £7}).

s

Rule WeightE 0(£= E4%E 0)22 £ I o] tid =5 &3] & & 4 A&U 7123 10

Zre u)82 9x5M 2. 181 Rule Guarantee= RuUle LIMILELT = & 9 1., Number of

guaranteed connections X pPer connection guaranteer Rule Limits 9= & & a4tk

=gl

7HEA]- B WFQ7} &=t

F 2HW Z-Z backlog #&l50l U # 3 2= ot ¥ Yo} oigt
Rule LimitE 2% 1 ¢J&

o) =
e tigEe 22 o sy

rlr

o] ol Track(£7: None:Log-Account), Install On(72-s H333t QlEjw|o] A — ToSIT
General Propertiesol| A #HA 3L QlEjm|o] A7} QoS ®oll A 2E ofoF &), Time(H Y
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A ZtH), Comment & 22 BHAl(£28] — Add/Edit) 22 ttE ULt Action 7| E7to 2
=] =2)# ™ Reset to Default & 44t}

w
=
o
=
=3
(¢}
ftlo
Rl
[ru
EE
j
§¥

g 717 }\H PR ,qu DefaultZ} 37 245 2344 Futt.
F&Uch A E 722 QoS Rule Treeont] mm i e =

=
H}H}j% oly _Fp‘d—r vd,
B, B 332 5142 2251 Rule Baseol| 1 52 A A7} Uebgduct.

DiffServ t}57]

DiffServ 72 = L4t F238 QoS Class?} 72X 201, 1 7452 o] g

AE|o| 2o ATk -8 HUT(E2 g A=A we] ).

-

DiffServ Class of Service = SmartDashboard®] Manage > QoS > QoS Classes ©i| 4|
New > DiffServ Class of Service & Tr=H, o] & AW E-A-g}Q](v]g] A 2]/Ar8-2} A 9])
S A oH(DiffServ code= ¢17] A& H|ER FEA]). of8] FYPAZE £+ (Class of Service

Group = -2 H o)A THEYT}.

QlEjH|o] A0 DiffServs Z& ™, Alo|Ego] Z4A|2] Network Management ©f| 4]
QlEjH|o] AL &of QoS ® > Add > DiffServ Classes > Others 2 SAE Hst,
Inbound/Outbound2 #/J3}5) RateZ &2 F Guaranteed bandwidth($-Al EAJE
2% o =)t Bandwidth Limit(o] =4 2o tig =) & (24 s ) Aot
Rule Baseol|= % o|=2] Add Class of Service > Above/Below 2 S~ 3|t =
dalet], X Soas golorn o1 A= orel Best_rrort ene 7+ LR o

Expedited Forwarding S2i4 £/d-2 <IEHo]A QoS §2] Add/Editol|lA] DiffServ
Classes > Expedited Forwarding 2= %2, Constant Bit Rate axima

(&4 33 AUt (RIAS E3 #2l2 =5). ARt DiffServ A £42 Others £
Zro ] Guaranteed bandwidther Bandwidth Limit = A3y oh(ell: &3 256 MB-Al| 5t
192MBH 192MB ZTHE-2 EA| ¢+ ).
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}\-]'O(:)]}\]— 71—‘% Al Hlg o= o= or S =uls OIL’]E]_<7HL§‘% »I'-:_h] ZQ-]i:}l-]

Low Latency Class = Manage > QoS > QoS Classes > New > Low Latency Class of
Service 2 TH=0] o] &-ZHE-A-E9l S At QlEjmo] Ao A
Smartbashpoards < g6 oA SmartConsole2] o] EgjJo] 4] — Network
Management — SlE{5o]A — QoS & 2 & 7}, Inbound/Outbound 43} & Add >
Low Latency Classes 2 Z#|AS 121 Tonstant Bit Rate? Maximal Delay = (24
Sk Hkeh) A oh(Ad 23t szl =5). Expedited ForwardingS DiffServ] &gt 2™

Maximal DelayE 999992 4t}

Alo|Ef| o] ] K7

QoS Security Gateway 4} Ei+= SmartConsole®] Gateways & Servers ©llA4] Alo|EQo|&

2959 ofefE Summary § o YebdY ).

2 53 A7

AZo] 210 FosH T2 o] groof gt} Alo|E9o] £4/d2] Additional
ToEEnE oA Q08 =08 =T 714 lojoF sti(7] 2oz #AK), 1 Az mH=s
7219] Track ¥E7} Log =+ Account 2 EA|Fofof gt} 2]o] 27 & &X]
215t SmartDashboardol|l A 722 2} Track 2=ol Log T Account/t J=A
BUch 2371 AR 2 o] A Ho|=A]L Logs & Eventsol| A th&Uct.
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Logs & Events

Logs & Events

x| = 2 = /|1 SmartConsole2| Logs & Events £ 1 215 HH{ QoS &
Mol & ==X| ELIE™SH= 40| o] Ze| =H|QYLICH EHE He= LHE QoS 2|0l CHEl 1,

7olo] 20| it

QoS 21+ =4 F-Accounting =1Ara 71=5) 2 Accounting 21(57| 7]12)
2 gyt

H]-Accounting 210 Al 7FA] & AHo] QI Uttt Connection Reject = B A2
e BT T e T Aane o aaol e s o2, 718e] Wojyt
T3] o]Eo] FEHtH(Recommended F-8). Running Out of Packet Buffers +

STETHO| g G 2] I T | = o2, FO 124000 of o 9F 2 u gyt
(Recommended %-&). LLQ Packet Drop 2 LLQ Z0jA mfjzlo] ojH S uwj 9
71208, o 50l g ¥ EuEm XA Tte g ol HiolE -+ A|A-AHE
<4 UYtH(Recommended H8).

Accounting 21+ AUt} General Statistics & A E{Ho]A-HFHZ QoSS At &
Hlo]E E(Recommended-Express 25), Drop POIICY STAlISUICS = Q00 84 Wz o]
A2 201" HFO|E Z(Recommended &), aliSUCs = a0 5

Z(Recommended H-&) g4yt

AZdo] 20| &= 242 o AolA 2 =YYt — Alo]Ef|o] £4d0A QoS £
27T AR Z0) AL, g a9 Tracko] Log e Account ofoF guct.

A
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27 AFA 9| A]
Connection Reject 21 = T8 o1 =2 2 AcCCept additional non-guaranteed

connections"7} AA A& wf F&UTth 230= rule_name: <class> <name> 3§24
o & o] FEfaet o]go] 7 EEYThell: rule_name:Best_Effort—udp2 ,

action reject ).

LLQ Drop 211 & L1LQ Zol|A mjzlo] Hojd uf, T = T ol 0] LLQ g == AlAron
iUt olg o] A-Hrek H=o](d: Server-InS s_in_ )2 HO1 A BIO| &

1lqg_drops

{ Llg_xmit_jitter 5, %%F A% Llg_recommended_delay ) ©] Y&Utc}. o] =
recommended_delay — EF& X4 Z 5t H LLQ A& &£/4d0) Y& Wk 7|2 2| A4k

olgt £5] 1 Yt

( 1lg_avg_xmit_delay ), - ( Tlg_max_delay ), A

ot
K

574 dejmo] Ao 27k P B 4 lFUth QoS7F Lol 24[ °F FAY, 1
I /\O B/\%/\7 ) H)\o © 514 HA —1\____- 7(:)]“(’)“?:}]’]E]—

Pool Exceeded 21 = SIHU[O[A-FeF(tdir) =2 Ad A7 B4=
E 37]-2Ejg o] A o] (outbound 5)0] 7|ZEYTH: Ifdir Memory Pool

Exceeded Pool_size:8 ).

Accounting $7] 21 oj|A]

Accounting 2710 &4 segment_time (JES 22 A]H) ©] Information Eo]

Zojrta, olu] Q)= lo|Ejyt 3t 21 g FEof o} Ho Zuc},

General Statistics = W3 A4 vlo|EQIUTHC: s_in_bytes:5768 ,
s_out_bytes:154294 ). Drop Policy Statistics = drop policy2 204 @oj% Hio|E
Z2(°): s_out_total_drops , 15 &G 272 Ho]X s_out_exceed_drops ), ©| drop
policy= 7! ¥ E #e|5h= WFRED7I ®5Uth. LLQ Statistics & &%°] LLQ Drop
2aek 29, A 27} opzt A AIARE FA5 THEUH
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QoS 7|&

Express?t Recommended F #3122 — “Juler 7[5 2l QoS7F E S ok

Recommended, 7] QoS = 235}H Express YUth. Expresst s

W Utct. Express—Recommended g2 EA|qt Hitj= ot gl g
¥ Express® AlZF6HA] 2 (AHA15]= QoS &7H).

-

Ao & 4= J= H 7= — 7HX= digkolst, f93 e 1Y £/449
Maximum weight of rule(7]% 1000, Y= H7 7

A A A2A7F 2 ok HTTP-FTP7F ZH 50091 Aol SMTP(100)S ©f5HH
HTTP+ 500/11002.2 A9] ot = x|qk, Z} 291 Aol SMTP(100)S ©slH 2/104% & =
olFUth & %7] 7kEA17t AW &S gl JFo] & HUr.

QoSE YR Qlelso] £ 3 ojtlell> — 5 o} 5147 T TERIOTZoT =T
Boo oy gyt

2R3 715219 ztole? — & of Wiy B Qi Eg BASoE 2 AT, B
Ak (ell: 20000bps), 7HEX] &= Adehigk(ell: 100) Yyt 1
=S 7h-7iy et o7t 1.5MB $]4doll HTTP Guarantee 1IMb-FTP Weight 40-:SMTP
Weight 100]H, TTA TTTTPOT IMB, B2 0-oMB= F1P 0.4 oM1P 0.1 2 Wsuth

_l

o
KT
o
(o]
N
oN
N
HL
u)
re
)

rlr

ulsiu? — obdUr). ojZelAlo|He Wad vt

?12) e d2ol ol 2t Z A2 HUoh Qosell= "dHE

-

C)
G Y ol
o

TCP AAEF2 o|FAI? — AHES AAISHH 1 dloE7} o]n] QoS ol A=A &2lsl,

w
o
Slom T @ UHRDED). ol Hol WAN TS I 00 s Do T oo
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£ Check Point AlEz}e] 7|
QoS Mult-Domain security Managementer gaor se 24t — VPN el ¢t

Ezfuo] Hstst 25, NAT Eefju B8, Y EQI M- EZ22 2§ 5. TmartView
MonTiore Q058 Gw/F ol e e/ Me = = Aw ©]1, QoSE W= ClusterxL w78
(Load Sharing ®3}) 3t NAT =an0 & 2H45] x|yt #el 753 QoS Alo| Ego]
o) £ Ayt Alo|Egolet Y 3, VoS ACT =0l = Hrelore i Management
Serveron= Qoos A aflof FHtt.

B =7

LLQ+= A2 — VoIP-2H =9 -5 HEH A8 2|4 B tjZo] Beskal W2 A
i

AE7FL g B AU ehaL

il
o,
_l U
rJ
iy

Rule Basex first matchQl7}? — . 90| X2 k= F2uk 28 =k 22§14 CEO
Eag F2 3 HTTP #32lo] S o, =— =0 Zd-2 2]
2o} ghychole = CEO2] YA o] HTTP Algtol| Z2d).

-

o]2] Ale|Eglo] 2] Rule Base 2% 22 — tj o] 2l JA = o™ Install On All
2, Y =o] thd| HHo] Zow (Hohzk obd) 758 HA shute] Hd g, Tho =

-—

ME 2L A2 — T ATolon AAT = o — ol R&D-Marketing 2% 22 24
T2RUYE HIEZES s fJdUch HES o] HE= A2 — CLIONA rtmtopsve &
Al B UTHCLI 2H%)
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8% W3t 5
wza] Q@ ke? — A7 Saof vlFS Tt 5,000 G0 of 32.DM B, H0,0000] of 01V B,
T00,0000°7 oF 156MB 7} Alo| Eglo]of] 2712 F a3t JZ2Y ~13008}0E, 7|2
AA o] & 25,000). StEQlojE? — 59 F 2212 CPU YUtt HEaE Zho] sl

20| 2o} S Y2 o] obguLic

if

L

e

}8]%%'1—6]%_ 2’]}1\_]_ QOS ]:H@,Q.E O}:'l]_j_EﬂO E; 7 T L.E— ol£& = A,
inbound AI$HS ¢+ 2™ outbound W&oTt A=, 245 2= F3
per-connection A|$H-E2A-S per-ruleZ A% o= A Y

TO0Bps Ut

TI.O
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2
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X
e
4
12
}F
O

A2 WA AT AU 2

D" /ERP}\‘]H.] % Zol'%?—s o — —|§EX'—| ‘—IX a . .

SAP-ORACLE & Z2EF)o] A &&= #2& st & 7F=E1v B3 2 sS4t

Qo0SE DoS 222 W}? — QoS+ DoS g == ol |1t DoSoll =] 2= 3
TICMP3 <F DRL)Z AT o1l T2 Sl (ERP M- VolP)ol =28 < 7 &A-ZYEfd-
ool & 4= AEUTH AFET hAZ Asto] G o] K2 — T AP ARSAL

= o] SUth T Z = Aot/ TS = =4
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Command Line Reference

QoS= SmartConsole-SmartDashboard2 2| Ct CHEX|2F FAOTE=OTONAT A =0l ==

HD NLt HMS 710 AEHE £ 1l = CLIZF 2QEtL|Ct 0] T2 QoSo| SHA!l Had —
etmstart-etmstop-fgate — & He[fLICt. QoS2| L H|2 0|E0]| fgd50(FloodGate-12)

=3H)olz2t BHOx fg 7F At EL|CH

=2

Scalable Platforms(Maestro-Chassis)oll 4= Txpert L CoNA] oG security Group onx]

= ddshioF gyt

72 87) %4

CLI 220 TIPS o 94Utk TR (1 S T el T,
A4 < > = AASAT} Aokl WA, TS [ ] S A s Ay P 2

rin
ol
1o
og
o

o

v
o
e —
T

u

=3hth So]A7](TAB) = 234



etmstart — QoS AJ&t

etmstart = 20| = oNOTONA| Qog ZoolEs A% St QoS | fgd50& =%,

$FWDIR/conf/masters ©f A% Management Servero|A QoS A& 7}4 JuUth

[Expert@MyGW:0]# etmstart

QoS: Starting fgdbh0

QoS: Fetching QoS Policy from masters
Fetching QoS Software Blade Policy:

Received Policy. Downloading...
ethO0(inbound), ethB(outbound).
Download OK.

Done.

QoS started

etmstop — QoS AA]

etnstop < HHIZ QoS =ool == Hw Ut The fgagﬁ—a— Ol 000 A= ey

(unload) F&UH HE&2 #5222 AAIASHT etmstop Foll etmstart & AFch.

[Expert@CXL1_192.168.3.52:0]# etmstop
Unloading QoS Policy:

QoS policy unloaded successfully.

QoS stopped




fgate — 3 Ax]-J=-dH

fgate £ A% 9x/of we} 22efo] 23 thE YL,

Management ServerolA =
HUTh. fgate load <EHME>.F <6W1> <6W2> .. = FAAES S Ao s 2| A
FToTESToToT 2 stal(H -2 2 324}, Alo|Egjol= w9l [P A o] &

fgate unload <GW.> = A7, fgate stat <GW.> +— AFEf, fgate ver + HAE

Hef F44-

[Expert@MGMT:0]# fgate load MyPolicy.F 192.168.3.52
QoS rules verified OK!

Downloading QoS Policy: MyPolicy.F...

MyGW: QoS policy installed succesfully.
Done.

Security Gatewayollq| = ©17]o] 2 714 2719} L Ao 7 Hsj A Utk A5 2=

2k 22 — fgate fetch -f + masters ¥ 2] X E Management Server©l|A] &

ZH
2
7hx ek Ax] (EA AH= fgate fetch <Abi> ), fgate load = =4 Q2 AA (A T)stH

etmstop — etmstart ), fgate unload = A|7], fgate stat [-h] = AYEH, fgate ver [-
k] =HA( -k A AE HH=)dYch

o] thoj] A&t Ao} & 40| QHUTE " fgate ctl <2E> {on|off} = QOO =& AOT
(R820| &2 etmreg #), fgate debug {on|off} + fgd50 Hl& o1 2 7}
ZHE $FGDIR/log/fad.elg ©f ‘F7]1, "fgate log {on|offlstat} = 71 @] QOO =4
T = Alojgchg ™ A=) glo] 7S A glas ek 7Hs). fgate kill [-t <AIS>]
<EZAA> T Q08 TEAZO Jes T Urh(R829] ZRA|lAL fgds50 #, AT E o FH

712 15(SIGTERM)).

[Expert@MyGW]# fgate fetch -f
Fetching QoS Software Blade Policy:

Received Policy. Downloading...
Download OK.
Done.




foate stat £ X 0 2o g o= HOT D= 12 B9 YUTh FHAEINE BE wH S E7o|

28 ofioF 5tm, 2HAIEH Ajo]-TlH 1= sk41585("How to control and debug QoS / FloodGate-

=2"0



A shetulg k2]

Working with Kernel Parameters

QoS L2 Software BladeX & A= 2ol so= e 2 3= QUEL|CE CHEt o] =
Hl= QoS ™E0] ofL|2} BE Security GatewayOll & O|2t, QoS 7I0|=0|A] 2 CHEX| @41
A|O|E<l[o] 7to|EE HZLILCE.

AtAISE A 2k= R82 Quantum Security Gateway Guide 2] "Working with Kernel
Parameters" % & ZastH Q. A oietu|EE B0 -8R0 -2 B E Follt §A|EA st

o] A7 ol A= AsHH-

o]o]Z]:= Kernel Debug® 72 Ao|Eg|o] 7lo] =& 7te|7iYtt.
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| B
k- a
Kernel Debug
QoS7t 7H'd +F0H| M O{E A SESH=X| 20| I S0{0f & = T2 e = &LICH 0] FA|

QoS M&0| ofL|2} Security Gateway &< Al 2, QoS 70| =0]|A = 2Lt Sk AH[O|EL[O|

7to|E2 FZLICh,

Ot

ALAISE A 2k= R82 Quantum Security Gateway Guide 2] "Kernel Debug on Security

Cateway g = Z15kA Q.

212 QoS Hl&(fgd50) 9] ¥ 1= CLI FXolA 2 fgate debug on OZ AHH, 1
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Appendix: Regular Expressions

QoS #£!0|A URI for QoS 2|AAZ HTTP EcfEl2 URL HEC=E A o ] HAHAHMS &
LICHQoS £t2|o| MH[A-2|aA FH1), O] RE2 Check Point7t oieh Y EHAl 2}, HO

= SAE QoS /r== HAlAE 247 & FelRfLot.

Check Point= EF AFEH A HEHEALE 79 A2 iyt \ & HEREA-H|EE
AP AL s escape oFal, [ ] = A =2l g, () £ 5k HE(ESol
WMEr=Ar A45), . < 999 gt &2 Ayt £ Fshe 7152& 2 (0~13]), * (03]

, {n} = A5 n3], {n,mr 2n~m3, {n,} =n3 ot =

al
Sohe SEE APAAUTE 2ol | £ 9Y, A TE (R 2o AF, $ = 2O

2252 o 2A2 selo] 22]W olof B442 escape FUTH EH R \n T

newlne(UA), \r = carriage return(OD); \t = abl09), \f = formieed(0C), \e <«

escapelib), \a — alarm/BEL07) Uttt FE2 2 ATt \ddd = o4 F,
\xhh =167 FE=, "\cX = control- X" = Uepduch
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EY T/ &4 & 71912 dix escapes %LJE}- \d — 1041 A

QoS 7} 117]-77)

QoS 470l B, R77 0|02 BHE QoS HRolA ol 752 2w

[0-9],

\D —‘:-';(‘X7

n= At o] LUt Ao EgoloA] cpconfig = oeCUrexl Corexi s Nl Alr g o

E]—}\] IIHI_ /\A‘]7]' H]—LHO]]/]L',]- U']X-] O]—E',H E—%— ]':é]f:’__ lﬂ, cpconfig E

SecureXL/CoreXLS A AjHg shct.

cpprod_util CPPROD_SetValue FG1 FgWithAcceleration 1 1 1
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